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Using Polling to Monitor Network Performance

Introduction to Performance Monitoring
An important component of efficient network management is the ability to receive performance
information on a large network of many devices to provide an overall view of the your network’s
functioning. You can then proactively manage your network elements by analyzing the performan
data.

CMNM lets you monitor the performance statistics gathered from network elements managed by CE
CMNM collects performance information from the Cisco MGC node, allowing you to monitor the hea
and performance of the network. You can display the performance information. You can also view
performance data associated with a given object and graph that data over time. CMNM collects
performance information from all of the components of the Cisco MGC node. You can configure 
objects being polled and the frequency of the polling.

Cisco MGC allows you to specify how long performance data should be kept in the database. Yo
also specify rollup rules and other actions that should be taken on performance data after a set len
time.

The Performance Manager is opened from the Network Maps, Event Browser, or Object Manage
selectingPerformance Managerfrom the pop-up menu available on a selected object. A screen sim
to  Figure 7-1 is displayed.
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Figure 7-1 Performance Manager Screen

A selected object or group of objects has a number of different attributes. You can choose to monit
area of the network, for example, the performance statistics of a particular attribute. This informa
could then be used to evaluate the performance of specific equipment and assess the requireme
upgrades or software downloads.

Performance statistics also provide a summary view of the performance of network elements. Th
statistics help you determine the degree to which the network is meeting assigned service levels. Y
able to drive down to the chassis level from the network level in a simple manner if you want to v
individual chassis statistics.

CMNM Performance Manager can present data in two ways:

• Raw—This is performance data in its most detailed format (not summarized). History storage
criteria defines which attributes are to be monitored on specified objects. When these objects
polled, the retrieved data is stored by CEMF and can be viewed using the Performance Man
This data is raw data. History storage criteria may also specify summary intervals and rules t
applied to the raw data. The resultant data is summarized data.

• Summarized—This gives derived summaries of raw data. This is an approach that displays the
at a level appropriate to the task in hand; for example, you may decide to view data summariz
hourly or daily intervals according to requirements.

Performance data has the potential to overwhelm. For example, you may want to view the Errore
Packets for a device over a six-month interval. If the data was displayed in a table or graph at the r
which it was sampled, this could be tens of thousands of values. In these circumstances, it is prefe
to view summaries of the data. For example, if data was originally received at intervals of 5 minutes
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ability to view it summarized in hourly, daily, or weekly intervals would be an excellent way of
managing the network. History storage criteria can be used to specify these summary intervals a
rules that are used to generate the summaries for the history storage criteria’s objects and attrib

Hourly summaries are generated on the hour, daily summaries are generated at midnight, and w
summaries are generated at midnight on Sundays (that is, the end of Sundays). For example, if 
starts at 9:30 and hourly summaries are to be generated, the first full hour’s worth of data is betw
10:00 and 11:00. So at 11:00, the first hourly summary is generated and given a timestamp of 10:00
same pattern is followed for all summaries (daily, weekly, or user-defined). This pattern standard
summary intervals so that all attributes’ summaries have the same timestamps.

Note Data generated between 9:30 and 10:00 is ignored in the above example, because an hourly
summary for 9:00 to 10:00 would be misleading as it would have been generated using only
half the usual number of values.

In some cases, an object may fail to be polled; for example, if communication to the object is lost.
is referred to as a missed poll, and all missed polls are indicated on Performance Manager grap
charts.

Performance Manager graphs and charts also indicate when an attribute started and stopped being
due to history storage criteria being added, edited, or removed. You are therefore able to see wh
polling on an attribute started, the attribute’s values while it was being polled (and any missed po
and finally when the attribute stopped being polled.

A Performance Manager can be opened for each network element you wish to monitor. To view
up-to-date information on the Performance Manager, clickRefresh and the selected data is displayed

How Performance Data Is Collected
Depending on the type of device, performance data is collected in different ways.

• Performance data for the active Cisco MGC host is collected by retrieving flat files at user-def
intervals.

• CMNM collects performance data from the Cisco SLT and LAN switch using the standard SN
mechanisms.

Common Performance Data Collected for Several Devices
Many devices collect the same performance data. Common performance attributes are listed in
Table 7-1, Table 7-2, and Table 7-3 and referenced in the following sections.

Table 7-1 IP Performance Counters

Counter Description

SNMP:RFC1213-MIB.ipInReceived Number of input datagrams received from interfaces,
including those received in error.

SNMP:RFC1213-MIB.ipInHdrErrors Number of input datagrams discarded due to errors in
their IP headers including bad checksums.

SNMP:RFC1213-MIB.ipInAddrErrors Number of input datagrams discarded because of inva
IP header destination address.
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SNMP:RFC1213-MIB.ipForwDatagrams Number of input datagrams for which this entity was n
their final IP destination.

SNMP:RFC1213-MIB.ipInUnknownProtos Number of locally addressed datagrams discarded
because of an unknown or unsupported protocol.

SNMP:RFC1213-MIB.ipInDiscards Number of input IP datagrams that were discarded fo
some reason (such as lack of buffer space).

SNMP:RFC1213-MIB.ipInDelivers Total number of input datagrams successfully delivere
to IP user-protocols.

SNMP:RFC1213-MIB.ipOutRequests Total number of IP datagrams that local IP user-protoc
supplied to IP in requests for transmission.

SNMP:RFC1213-MIB.ipOutDiscards Number of output IP datagrams that were discarded 
some reason (such as lack of buffer space).

SNMP:RFC1213-MIB.ipOutNoRoutes Number of IP datagrams discarded because no route
found to transmit them to their destination.

SNMP:RFC1213-MIB.ipFragOKs Number of IP datagrams that have been successfully
fragmented at this entity.

SNMP:RFC1213-MIB.ipFragFails Number of IP datagrams that have been discarded
because they could not be fragmented.

SNMP:RFC1213-MIB.ipFragCreates Number of IP datagram fragments that have been
generated as a result of fragmentation.

Table 7-2 TCP Performance Counter

Counter Description

RFC1213-MIB.tcpActiveOpens Number of times TCP1 connections have made a direct transition to
the SYN-SENT state from the CLOSED state.

RFC1213-MIB.tcpAttemptFails Number of times TCP connections have made a direct transition
the CLOSED state from either the SYN-SENT state or the
SYN-RCVD state, plus the number of times TCP connections hav
made a direct transition to the LISTEN state from the SYN-RCVD
state.

RFC1213-MIB.tcpCurrEstab Number of TCP connections for which the current state is eithe
ESTABLISHED or CLOSE-WAIT.

RFC1213-MIB.tcpEstabResets Number of times TCP connections have made a direct transitio
the CLOSED state from either the ESTABLISHED state or the
CLOSE-WAIT state.

RFC1213-MIB.tcpInErrs Total number of segments received in error (for example, bad TC
checksums)

RFC1213-MIB.tcpInSegs Total number of segments received, including those received in
error.

RFC1213-MIB.tcpMaxConn Total number of TCP connections the entity can support.

RFC1213-MIB.tcpOutRsts Number of TCP segments sent containing the RST flag.

Table 7-1 IP Performance Counters
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Performance Data Collected for the Cisco MGC Hosts
The following performance counters are collected for each Cisco MGC host:

• IP performance counters

• TCP performance counters

• UDP performance counters

In addition, the attributes in Table 7-4 are collected for the active Cisco MGC host.

Performance Data Collected for BAMS
The following performance counters are collected for each BAMS:

• IP performance counters

• TCP performance counters

RFC1213-MIB.tcpOutSegs Total number of segments sent, including those on current
connections but excluding those containing only retransmitted
octets.

RFC1213-MIB.tcpPassiveOpens Number of times TCP connections have made a direct transitio
the SYN-RCVD state from the LISTEN state.

RFC1213-MIB.tcpRetransSegs Total number of segments retransmitted - that is, the number of
segments transmitted containing one or more previously transmitte
octets.

RFC1213-MIB.udpInDatagrams Total number of UDP2 datagrams delivered to UDP users.

1. Transmission Control Protocol

2. User Datagram Protocol

Table 7-3 UDP Performance Counters

Counter Description

RFC1213-MIB.udpInDatagrams Total number of UDP datagrams delivered to UDP users.

RFC1213-MIB.udpInErrors Number of received UDP datagrams that could not be delivered
reasons other than the lack of an application at the destination po

RFC1213-MIB.udpNoPorts Total number of received UDP datagrams for which there was
application at the destination port.

RFC1213-MIB.udpOutDatagrams Total number of UDP datagrams sent from this entity.

Table 7-2 TCP Performance Counter

Table 7-4 Cisco MGC Host Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrSystemNumUsers Number of users on the host

SNMP:HOST-RESOURCES-MIB.hrSystemProcesses Number of processes running on system
7-5
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• UDP performance counters

In addition, the attributes in Table 7-5 are collected.

Performance Data Collected for the Cisco SLT
The following performance counters are collected for each Cisco SLT:

• IP performance counters

• TCP performance counters

• UDP performance counters

In addition, the attributes in Table 7-6 are collected.

No performance collection is done for the SS7 MTP2 channels.

For details on collecting performance data for the Cisco SLT TDM interfaces, see “Performance 
Collected for TDM Interfaces” section on page 7-7.

Performance Data Collected for the LAN Switch
The following performance counters are collected for each LAN switch:

• IP performance counters

• TCP performance counters

• UDP performance counters

In addition, the attributes in Table 7-7 are collected for the IOS LAN switch.

The attributes in Table 7-8 are collected for the Catalyst LAN switch.

Table 7-5 BAMS Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrSystemNumUsers Number of users on the host

SNMP:HOST-RESOURCES-MIB.hrSystemProcesses Number of processes running on the sys

Table 7-6 Cisco SLT Performance Counters

Counter Description

SNMP:OLD-CISCO-CHASSIS-MIB.nvRamUsed Amount of RAM in use

Table 7-7 IOS LAN Switch Performance Counters

Counter Description

SNMP:OLD-CISCO-CHASSIS-MIB.nvRamUsed Amount of RAM in use
7-6
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Performance Data Collected for Network Interfaces
The performance counters in Table 7-9 are collected for each network interface.

Performance Data Collected for TDM Interfaces
The counters in Table 7-10 are collected for each Cisco SLT TDM interface to the SS7 network.

Table 7-8 Catalyst LAN Switch Performance Counters

Counter Description

SNMP:CISCO-STACK-MIB.sysTrafficPeak Peak traffic utilization

Table 7-9 Network Interface Performance Counters1

1. No performance attributes are collected for loopback interfaces.

Counter Description

SNMP:IF-MIB.ifInErrors Number of inbound packets that contained errors preventing them fr
being deliverable to a higher-layer protocol.

SNMP:IF-MIB.ifInOctets Total number of octets received on the interface, including framing
characters.

SNMP:IF-MIB.ifOutErrors Number of outbound packets that could not be transmitted because
errors.

SNMP:IF-MIB.ifOutOctets Total number of octets transmitted out of the interface, including fram
characters.

Table 7-10 TDM Interface Performance Counters

Counter Description

SNMP:RFC1406-MIB.dsx1TableBESs1

1. Table refers to the RFC-1406 DSX1 table and is either Current or Total.

Number of bursty errored seconds

SNMP:RFC1406-MIB.dsx1TableCSSs Number of controlled slip seconds

SNMP:RFC1406-MIB.dsx1TableDMs Number of degraded minutes

SNMP:RFC1406-MIB.dsx1TableESs Number of errored seconds

SNMP:RFC1406-MIB.dsx1TableLCVs Number of line code violations

SNMP:RFC1406-MIB.dsx1TableLESs Number of line errored seconds

SNMP:RFC1406-MIB.dsx1TablePCVs Number of path coding violations

SNMP:RFC1406-MIB.dsx1TableSEFSs Number of severely errored framing seconds

SNMP:RFC1406-MIB.dsx1TableSESs Number of severely errored seconds

SNMP:RFC1406-MIB.dsx1TableUASs Number of unavailable seconds
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Performance Data Collected for the Cisco 2900XL LAN Switch Port
In addition to the standard interface attributes, the counters in Table 7-11 are also collected for t
Cisco 2900XL port.

Performance Data Collected for the CIAgent System Components
The following sections list the attributes collected for each CIAgent system component.

Note For information about viewing this information, see the “Viewing CIAgent Device
Information” section on page 9-36.

Fixed Disk

The counters in Table 7-12 are collected for each fixed disk object.

Table 7-11 Cisco 2900XL LAN Switch Port Performance Counters

Counter Description

SNMP:CISCO-C2900-MIB.c2900PortRxNoBwFrames Frames discarded due to lack of
bandwidth

SNMP:CISCO-C2900-MIB.c2900PortRxNoBufferFrames Frames discarded due to lack of bu

SNMP:CISCO-C2900-MIB.c2900PortRxNoDestUniFrames Number of unicast frames discard

SNMP:CISCO-C2900-MIB.c2900PortRxNoDestMultiFrames Number of multicast frames discard

SNMP:CISCO-C2900-MIB.c2900PortRxFcsErrFrames Frames received with an FCS erro

SNMP:CISCO-C2900-MIB.c2900PortCollFragFrames Frames whose length was less tha

SNMP:CISCO-C2900-MIB.c2900PortTxMulticastFrames Frames successfully transmitted
(mutlicast)

SNMP:CISCO-C2900-MIB.c2900PortTxBroadcastFrames Frames successfully transmitted
(broadcast)

Table 7-12 Fixed Disk Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrStorageAllocationFailuresNumber of failed allocation requests

SNMP:HOST-RESOURCES-MIB.hrStorageUsed Amount of storage used
7-8
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Processor

The counters in Table 7-13 are collected for each processor object.

RAM

The counters in Table 7-14 are collected for each RAM object.

Virtual Memory

The counters in Table 7-15 are collected for each virtual memory object.

Cisco MGC Host Configuration Performance Counters
The Cisco MGC host writes out performance counters for many of the signaling components. Th
performance counters are in the form of ASCII flat files containing entries for all collected counters
all signaling components.

Performance data is stored directly on the signaling components themselves. You only see the
performance data for any given component, not for all signaling components. All performance cou
are predefined in the CEMF object model.

On the Cisco MGC host, you can specify multiple intervals for any given counter. For example, you
specify that a counter is to be written for each 5-minute, 15-minute, 30-minute, 60-minute, and 24-
interval. However CMNM supports only a single interval for any given counter.

The Cisco MGC host administrator must ensure that the performance configuration writes out ea
counter only at a single interval by modifying the measProfs.dat and buckets.dat files so there is o
single entry (time interval) for each category. The administrator should choose the most granular int
(shortest time) necessary for each counter. If the administrator fails to do this and the Cisco MGC

Table 7-13 Processor Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrDeviceErrors Number of errors detected on device

SNMP:HOST-RESOURCES-MIB.hrProcessorLoad Average load on the processor

Table 7-14 RAM Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrStorageAllocationFailuresNumber of failed allocation requests

SNMP:HOST-RESOURCES-MIB.hrStorageUsed Amount of storage used

Table 7-15 Virtual Memory Performance Counters

Counter Description

SNMP:HOST-RESOURCES-MIB.hrStorageAllocationFailuresNumber of failed allocation requests

SNMP:HOST-RESOURCES-MIB.hrStorageUsed Amount of storage used
7-9
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writes out the same counter at multiple intervals, CMNM collects all data points and stores them in
same attribute, causing spikes in the resulting performance displays. For this reason, the user m
configure the Cisco MGC host such that each measurement is written out only at a single time in

On the Cisco MGC host, there are a number of files that determine which performance counters 
collection as well as the frequency of their collection, as shown in Table 7-16.

Measurement Filters
You can use measurement filters to specify the Cisco MGC host configuration performance counter
CMNM collects. Although the Cisco MGC host continues to write out all of its configuration
performance counters, CMNM collects only the subset defined in its measurement filters.

During startup, CMNM reads the measurement filter file:

$CEMF_ROOT/config/hostController/measFilters

This file contains a list of all of the Cisco MGC host configuration performance measurements th
CMNM collects. It lets you filter counters based on their measurement names and the MML compo
names.

The format of the measurement filter file is:

Measurement Name, *|Component Name

where the variables are defined in Table 7-17.

Opening the Performance Manager
The Performance Manager can be accessed from pop-up menus on selected objects in the follow
applications:

• Network Maps

• Event Browser

Table 7-16 Cisco MGC Host Measurements File

MGC Host File Description

buckets.dat Defines the measurement buckets and intervals and their associated thresholds

dmprSinks.dat Defines how often the performance counters are to be collected and the maximu
number of records and the maximum file size of the CSV files.

measCats.dat Defines all of the counters in each category to be generated by the Cisco MGC
software.

measProfs.dat Defines the profiles associated with each measurement category, including
information concerning reporting intervals and measurements.

Table 7-17 CMNM Measurement Filters

Parameter Description

Measurement NameAny measurement specified in the Cisco MGC host measCats.dat file.

Component Name Any MML component specified in the Cisco MGC host components.dat file. A
asterisk (*) matches all components.
7-10
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• Object Manager

To open Performance Manager:

Step 1 Open the appropriate window to display a relevant object.

Step 2 Place the cursor over the object.

Step 3 Press and hold the right mouse button.

Step 4 Move the cursor until theToolsoption is highlighted, then highlight thePerformance Manageroption,
as shown in Figure 7-2.

Figure 7-2 Map Viewer Screen—Tools->Performance Manager Option

Step 5 Release the right mouse button.

You see the Performance Manager screen shown in Figure 7-3.
7-11
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Figure 7-3 Performance Manager Screen

From the Performance Manager screen you can:

• Identify all monitored attributes on a selected managed object.

• Identify all time periods configured for sampling each monitored attribute.

• Identify all summary methods configured for selected monitored attributes and selected sum
periods.

• View historical performance data over a requested period of time (in tabular or graphical form

• Print performance data to a printer or file.

Setting Polling Frequencies
You can set the polling frequency for the various types of devices. While you can specify a separ
polling frequency for the Cisco SLTs, the LAN switches, and the Cisco MGC hosts, you cannot s
separate polling frequency for an individual device.

Performance information display

Time
period

start

Time
period

end

Refresh

Summary

Monitored attributes

Bar chart 29
87
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Understanding the Different Polling States of a Device
When an object is polling, its icon is augmented with a small anotation. Each LAN switch, Cisco 
and common Cisco MGC host object has this icon when polling. In addition, the Cisco MGC node ob
has the polling icon if any of its children are doing polling. In this way, the states of the Cisco MG
subobjects are reflected up to the Cisco MGC node object.

CMNM uses many different indicators to indicate the logical state of a device. On the right side o
Map Viewer, the icon representing each device is shown. For some states, a small symbol is place
the top of the icon to indicate a logical state. In addition, cross-hatching is used to indicate state
information.

Table 7-18 shows the different logical states.

Table 7-18 State Symbols

State Symbol Description

Indicates that the device has not been discovered. (This is the icon when the devic
is initially deployed.)

Indicates that the device is in the process of discovering. The icon also has a hatc
pattern.

Indicates that the device has some outage or operational problem and is, therefore
out-of-service. Icons also have a hatch pattern.

Indicates that the device is performing polling.

Indicates that the device is not SNMP reachable. This may be because the device 
off the network or its SNMP agent is not responding.

Indicates that some major service or software process on the device has failed. Th
icons also have a hatch pattern.

Indicates that the device is off-duty or administratively down.

Indicates that the device is providing service.

Indicates that the device is running in warm-standby mode.

Indicates that the device is running in an unknown (other) mode.

Indicates that the device is being tested.

A hatch-pattern (without any corresponding state symbol) is used to indicate that the
device is not being managed.

<None> An icon with no hatch pattern or symbol indicates the device is running normally.
7-13
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Changing Collection Defaults
CMNM predefines which performance statistics are collected and simply processes whatever da
available. However, the Cisco MGC host allows you to change these defaults by editing the
Cisco MGC host filter file perfMeasFilters. Use the following commands:

install directory/config/hostController

perfMeasFilters

Measurements can be turned on or off by commenting out the line with # or by deleting the line.

Setting Different Polling Frequencies
You can define the polling frequency for the various devices, but you should not set the CMNM pol
frequency to be less than the Cisco MGC host polling frequency. However, you can increase the CM
polling frequency so that not all of the Cisco MGC host performance files are processed. For exa
you can set Cisco MGC host performance data collection to only once a day.

To configure the polling frequency:

Step 1 On the Map Viewer screen, select the device you want to configure.

Step 2 Right-click to display the pull-down menu and selectStates, as shown in Figure 7-4. (This example use
a Cisco SLT, but the procedure is the same for other devices.)
7-14
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Figure 7-4 Map Viewer Screen—Tools>Open Polling Frequencies Option

You see the screen in Figure 7-5.
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Figure 7-5 Polling Frequencies Screen

Step 3 You can set the frequency for performance polling, status polling, and auto-discovery. To change
minutes to hours, select from the pull-down menu, as shown in Figure 7-6.
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Figure 7-6 Polling Frequencies Screen—Frequency Pull-Down Menu

Starting Polling On a Device
By default, performance data is not collected for any object. When an object is first deployed in CE
it is in the normal state; no performance polling is done. To enable performance polling, you mus
transition the object into the polling state. This is done using the dialogs posted from the object. CM
allows you to transition either a single object or a group of objects between the normal and polling s

To place a device into a polling state so that data can be collected (this example uses the Cisco SL
the procedure is the same for each device):

Step 1 Click the network or device, right-click to display the pull-down menu, then selectStates as shown in
Figure 7-7.
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Figure 7-7 Map Viewer Screen—Open SLT States Option

You see the screen in Figure 7-8.
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Figure 7-8 SLT States Screen

Step 2 Click Start Polling.

You see the screen in Figure 7-9.

Figure 7-9 Polling Configuration Prompt

Step 3 Click Yes to proceed.

To stop polling at anytime during the process, clickStop Polling, as shown in Figure 7-10.
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Figure 7-10 Stop Polling Screen

Note Starting and stopping polling on the Cisco MGX 8260, Cisco SLTs, and LAN switch also
starts or stops polling for each interface on the chassis.

Note When polling is taking place, a sheet with an arrow pointed up appears just above the
network or object icon. Figure 7-11 shows the 2600a-Ethernet-1 and 2600a-Serial-8 in
polling states.

Figure 7-11 Map Viewer Screen—2600a in Polling State

Decomissioning, Rediscovering, and Rebooting Devices
You can commission or decomission devices such as the Cisco SLT, LAN switch, Cisco MGX 82
BAMS, and Cisco MGC host.

Decommissioning a device prevents it from being presence polled or performance polled. A devi
the decommissioned state still processes traps, but a presence poll alarm is cleared. Commissio
brings it back on the network so that it starts presence polling.

The decommissioned state is used in two circumstances:

• When the physical device is administratively off the network.

• When the physical device has a known problem and you do not want to manage it.

44
83

2
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When a trap is received, CMNM checks to see if the destination object is decommissioned. If so, the
is discarded. Otherwise trap processing continues as normal. In this way, you never receive any tra
a decommissioned device.

Rediscover performs subrack discovery on the device and synchronizes all of the network interface
IP addresses. Rebooting shuts down and restarts the device.

To decomission, rediscover, or reboot a device:

Step 1 Click the network or device, right-click to display the pull-down menu, then selectStates as shown in
Figure 7-12.

Figure 7-12 Map Viewer Screen—Open SLT States Option

You see the screen in Figure 7-13.
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Figure 7-13 SLT States Screen

Step 2 Click theStates tab.

You see the screen in Figure 7-14.
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Figure 7-14 SLT States Screen

Step 3 Click the relevant button to accomplish the task you want to perform.

Viewing Performance Data
CMNM generates simple graphs of performance data (single counter, single object). These screen
the performance data in tabular, near real-time format for SS7, SS7 Link, SS7 Link Set, Voice Tr
and Interface Utilization measurements. The performance counters associated with these measur
include, but are not limited to:

• Calls cancelled because of CCS congestion

• Number of transmitted IAM messages

• Received answer signaling

• Number of received IAM messages

• Number of transmitted CCS answer signals

• Number of attempts to transmit IAM messages

• Number of MSUs transmitted and received

• Duration of Level 1, 2, and 3 congestion
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To view performance data, you need to select:

• Attributes for which performance data is to be displayed

• Time period over which the performance data is gathered

• Format to be used to display the results

Note Before you can view performance data, you must first start performance monitoring on a
device or network and wait until polling is complete.

Step 1 Open the Performance Manager. The window shows the name of the selected object.

Step 2 From the Monitored Attributes list, select the attribute to be monitored.

Note You can select multiple attributes in a list by holding down theShift key and
selecting attributes in the list. You can select multiple individual attributes by
holding down theCtrl  key and clicking individual items. The information for all
selected attributes is shown in the Table Display. Only the first selected attribute is
shown in the line chart or bar chart.

Step 3 In the Start Date data entry boxes, enter the date the view of the performance statistics has to star
The format ismm/dd/yyyy.

Step 4 You set a start time and an end time using 24-hour notation. The times are inclusive. In the Start
data entry boxes, enter the time the view of the performance statistics has to start on the Start D

Step 5 To set the End Date you have two options:

In the End Date data entry boxes, enter the date the view of the performance statistics has to sto
format must bemm/dd/yyyyor select theNow check box to view the data from the selected start date
the current time. By selecting this option, you do not have to update the End Date and End Time f

Note Now is the current time and remains current.

Step 6 To set the End Time you have two options:

In the End Time data entry boxes, enter the time the view of the performance statistics has to stop
End Date or select theNow check box to view the data from the selected start date to the current t
By selecting this option, you do not have to update the End Date and End Time fields.

Step 7 From the Interval pull-down menu, select the summary interval to be used. This varies according t
attribute selected. The summary interval is the period of time over which the rule is applied. This
pull-down menu always contains the option to selectraw. This displays the data in raw format, which is
performance data in its most detailed format (not summarized).

Note When raw is selected, the Bar Chart view is not available and the Summary Rule
option is grayed out.
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Step 8 From the Rule pull-down menu, select the summary rule to be used. This gives you the option to
summarize data to a lower granularity as follows:

• Total—Totals all values gathered in the summary period

• Average—Takes the average of all values gathered in the summary period

• Min—Presents the lowest value received over the summary period

• Max—Presents the highest value received over the summary period

• Logical OR—Displays either 1 or 0. This is typically used for status flags. Some attributes may h
only two potential values (such as, true or false; yes or no; 1 or 0). When summaries are gene
from values such as these, and the logical OR rule is used, the summarized value is 1 if any va
the summary interval is 1. If all values in the summary interval are 0, then the summarized value

Note The Summary Rule option is not available when the option to view raw data is
selected.

Note The default summary rule is one day (24 hours).

Step 9 Click Refresh.

Note The Refresh button is blue when it is available for selection. It is grayed out when
not available. The Refresh button is available for selection when Now is selected,
or when any criteria has changed and you have moved the cursor away from the
changed value by clicking theTab key or by using the mouse.

Note SNMP data (that is, data collected from the Cisco SLT and LAN switch) is
refreshed in near real-time. When data is collected from the active Cisco MGC
host, you can manually collect and display the current performance data by
clicking Refresh. Refresh simply refreshes the Data view to display the latest data
collected during polling. To update the data, you must start polling again.

By default, a line chart of the performance information, to date, is displayed. You can view performa
information in the following formats:

• Line Chart, refer to Figure 7-15

• Table Display, refer to Figure 7-16

The performance information displayed corresponds to the attributes’ raw values. If a summary p
is selected, the information is displayed according to the Summary Rule. No summary period is
associated with raw data.

Note In some circumstances, an object may fail to be polled. All missed polls are
indicated on graphs and charts by yellow points that show the last valid value
collected. A missed poll affects the summary data, and the data should not be relied
upon.
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CMNM graphs and charts also indicate when an attribute started and stopped being polled due to h
storage criteria being added, edited, or removed. Start and end polling events are shown in char
tables:

• The start polling events point is shown in green.

• The end polling events point is shown in red.

Note A Polling Events key is displayed.

Figure 7-15 Sample Line Chart Screen

Figure 7-16 Sample Table Display Screen
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Viewing Raw Data
You can view raw data as it is received without any summarization. History storage criteria define w
attributes are to be monitored on specified objects. When these objects are polled, the retrieved 
stored by CEMF and can be viewed using the Performance Manager. This data is raw data. Hist
storage criteria may also optionally specify summary intervals and rules to be applied to the raw
The resultant data is summarized data.

Note The Summary Rule option and the Bar Chart view are not available when the option to view
raw data is chosen.

Step 1 Launch the Performance Manager.

Step 2 Choose the desired attributes and set the dates and times, as described in the “Viewing Perform
Data” section on page 7-23.

Step 3 From the Summary Interval pull-down menu, selectraw.

Step 4 Click Refresh.

The new performance information displayed corresponds to the attributes value returned during th
period.

Note The Refresh button is blue when it is available for selection. It is grayed out when not
available. The Refresh button is available for selection when Now is selected or when any
criteria has changed and you have moved the cursor away from the changed value by
pressing theTab key or by using the mouse.

Viewing a Chart
You can zoom in, zoom out, and move around the displayed charts by using the keys and mouse b
described in Table 7-19. Note that you must select a chart before invoking these actions.

Table 7-19 Chart Viewing Actions

Press Action

Shift and left mouse button To select multiple attributes in a list.

Up arrow key Scrolls up the Table display.

Down arrow key Scrolls down the Table display.

Left mouse button Clicking and dragging with the left mouse button over an area zooms in
that section of the chart. You cannot zoom in on a chart that has a scr
bar.

Middle mouse button Takes the view back one zoom level after zooming in using the left mo
button.
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Viewing Points and Values on a Line Chart

You can choose to annotate a line chart with color-coded points that represent the polling status. Yo
also show the values associated with each point.

Step 1 From the View menu, selectPoints. This annotates the line chart with points, which visually indicate th
points that are presented in tabular form in the Table Display. A point is colored-coded to show po
status as follows:

• Black—Poll

• Red—Stopped polling

• Green—Started polling

• Yellow—Missed poll

Step 2 From the View menu, selectValues. This option shows the values associated with each point, which a
presented in tabular form in the Table Display.

The values are shown on each chart until the item is deselected in the View menu.

Viewing a Performance Log
Performance data is saved in a log. To view data from past pollings:

Step 1 Using the instructions in the “Viewing Performance Data” section on page 7-23, select the followin
define the data you want to view:

• Start time and date

• End time and date (selectNow for current data)

• Summary interval

• Summary rule

Step 2 Click Refresh.

Setting How Performance Data Is Archived
CMNM allows you to specify how long performance data should be kept in the database. You ca
specify roll-up rules and other actions that should be taken on performance data after a set length o

CEMF manages a database of performance data values, and ensures the database does not gro
indefinitely. This is achieved by purging data that is deemed to be old. Several rules are used to dete
what data should be purged based on the concept of samples. A sample is either a collection of raw
or a collection of data that has been summarized using one summary rule for one summary inter
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The attributeHistoryServer.ini file, described in Table 7-20, controls the behavior of the performan
purging mechanism:

minValueCount   = 50
maxValueCount   = 1000
minRawDataAge   = 60

In some cases, these three settings may conflict with history-storage-criteria summary intervals. 
example, if the history storage criteria specifies that only daily summaries are to be generated, b
purging criteria specify that one full day’s worth of raw data is never available, then the daily summa
could not be generated if the purge settings were followed. In such cases, data is not purged unt
summaries that depend on that data have been generated.

These values can be modified using the historyAdmin utility.  However these values have a signif
effect on database size and performance. As such, care must be taken when changing these para
because the settings have a direct association with overall disk requirements.

Note For information on configuring how alarms are stored and deleted, see the“Setting How
Long Alarms Are Stored” section on page 8-49.

Exporting Performance Data
CEMF has an exporting facility that lets you write performance data to an ASCII file. Using the
historyAdmin export command, the northbound system can generate files that contain the perform
data for an object during a selected interval.

Note CMNM does not provide any CORBA or GUI interface to the CEMF history export
facilities. You must manually perform the export (using the command
/opt/cemf/bin/historyAdmin export filename), or the northbound system must perform it
using Telnet or another facility.

Table 7-20 attributeHistoryServer.ini file Attributes

Parameter Description

minValueCount Specifies the minimum number of values to be kept for each sample. Data is
never removed from a sample if doing so would result in that sample having
fewer than this number of values. This value is set to 50 on a standard CEMF
installation.

minRawDataAge Specifies the minimum age of raw data (in seconds) that must be kept. Raw
data younger than this age is never removed. This value is set to 60 on a
standard CEMF installation. For example, if the system has just received 100
changes to an attribute in the 40 seconds preceding a purge, then the last 100
values would be kept and not just the last 50.

maxValueCount Specifies the maximum number of values to be kept for each sample.
Whenever this number of values is reached for a sample, values are removed
until either of the first two settings would be breached if any more were
removed. This value is set to 1000 on a standard CEMF installation.
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The data is exported in the following format:

Object:<object path>
Object class:<object path>
Attribute: <attribute name>
Summary rule:<rule>
Summary interval: Raw | <summary interval>
<date> <time> <valueType> <value>
<date> <time> <valueType> <value>
...
Data exported: <current date/time>

For example, a sample file looks like:

> historyAdmin export dumpFile TAB 10 all criteria1
Object: exampleView:/site_1/bay_1/agent_1/rack_1/linecard_2/port_2
Object Class: testPort
Attribute: LocalDB:TEST.dtIndex1
Summary interval: Raw
09 Jun 1999 11:50:03 Polled 10
09 Jun 1999 11:50:23 Polled 10
09 Jun 1999 11:50:43 Polled 15
09 Jun 1999 11:51:03 Missed <no value>
09 Jun 1999 11:51:23 Polled 20
09 Jun 1999 11:51:43 Polled 20
09 Jun 1999 11:52:03 Polled 0
09 Jun 1999 11:52:23 Polled 5
09 Jun 1999 11:52:43 Polled 0
09 Jun 1999 11:53:03 Polled 10
Data exported: Sun Jun 27 17:17:35 1999

Printing a Performance File
You can print performance statistics from the Performance Manager, either as a chart or as a tab
chart prints out the information that can be seen in the window. A table prints out all of the performa
statistics in a plain text format.

The output is printed by the default printer setup on your network.

Step 1 Open the Performance Manager and select the desired performance statistics.

Step 2 From theFile menu, selectPrint . Choose eitherAs Chart or As Table.
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